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แบบทดสอบผลสัมฤทธิ์ทางการเรียน 
เรื่อง การใช้งานโปรแกรม Microsoft Office PowerPoint 2007 

 
คําแนะนํา ให้นกัเรียนทําเครื่องหมาย X ที่ข้อคําตอบทีน่ักเรียนเห็นว่าถูกต้องทีสุ่ดเพียง 

 ข้อเดียว จํานวน 40 ข้อ เวลา 1 ช่ัวโมง 

1. โปรแกรม PowerPoint 2007 เปน็โปรแกรมทีเ่หมาะสําหรับงานประเภทใด 

 ก. ด้านการคํานวณ     ข. ด้านการจดัการฐานข้อมูล  

 ค. ด้านการสร้างงานนําเสนอ  ง. ด้านงานเอกสาร 

2. ข้อใดคือข้ันตอนการเปดิโปรแกรม PowerPoint 2007 ที่ถกูต้อง  

 ก. File > Close 

 ข. View > Toolbars 

 ค. File > Exit > Microsoft PowerPoint 2007 

 ง. Start > Programs > Microsoft Office > Microsoft Office PowerPoint 2007 

3. ส่ือในข้อใดท่ีไม่สามารถนํามาใส่ในโปรแกรม PowerPoint 2007 เพ่ือประกอบการนําเสนอ  

 ก. วีดีโอ        ข. ส่ิงมีชีวิต 

 ค. ภาพเคลื่อนไหว     ง. กราฟ 

4. มุมมองใดใช้สําหรับแสดงและจัดเรียงลําดับสไลด์ในโปรแกรม PowerPoint 2007 

 ก. มุมมองปกติ      ข. มุมมองแสดงลําดับสไลด์  

 ค. มุมมองนําเสนอภาพนิง่   ง. มุมมองบนัทึกย่อ 

5. ข้ันตอนที่สามของการเตรียมการนําเสนอด้วย PowerPoint 2007 คืออะไร  

 ก. เตรียมข้อมูล      ข. นําเสนอจริง 

 ค. จัดทํางานนําเสนอ    ง. ซักซ้อมก่อนนําเสนอจริง 

6. ข้อใดต่อไปนี้กล่าวไม่ถูกต้อง 

 ก. Minimize ปุ่มย่อหน้าต่างโปรแกรมให้เต็มหน้าจอ 

 ข. Maximize ปุ่มขยายหน้าต่างโปรแกรมให้เต็มหน้าจอ  

 ค. Restore ปรุงปรบัหน้าต่างโปรแกรมให้กลับสู่ขนาดเดิม  

 ง. Close ปุ่มปดิหน้าต่างโปรแกรม 
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7. ข้อใดกล่าวได้ถูกต้องเกี่ยวกับ Title Bar  

 ก. แถบเมนูคําส่ังต่างๆ             

 ข. พ้ืนที่สําหรบัตกแต่งสไลด์ 

 ค. แถบแสดงชื่อโปรแกรม และช่ือไฟล์ทีก่ําลังเปิดใช้งานอยู่  

 ง. ส่วนทีแ่สดงเค้าโครงของข้อความที่อยู่ในสไลด์ 

8. Slide Area อยู่ในมุมมองใด 

 ก. Slide Tap       ข. Normal View 

 ค. Slide Show      ง. Outline Pane 

9. ข้อใดคือพ้ืนที่สําหรับออกแบบและตกแต่งสไลด์  

 ก. Menu Bar      ข. Task Pane 

 ค. Slide Area      ง. Note Pane 

10. ข้อใดคือข้ันตอนการซ่อนและแสดงเครื่องมือทีถู่กต้อง  

 ก. แฟ้ม > รูปแบบ > เลือกช่ือแถบเครื่องมือที่ต้องการ 

 ข. รูปแบบ > แถบเครื่องมือ > เลือกช่ือแถบเครื่องมือที่ต้องการ 

 ค. แทรก > แถบเครื่องมือ > เลือกช่ือแถบเครื่องมือทีต่้องการ 

 ง. มุมมอง > แถบเครื่องมือ > เลือกช่ือแถบเครื่องมือที่ต้องการ 

11. ข้อใดต่อไปนี้กล่าวไม่ถกูต้องเกี่ยวกบัแฟ้ม > สร้าง และแทรก > สร้างภาพนิง่ 

 ก. แฟ้ม > สร้าง เปน็การสร้างไฟล์งานนาํเสนอชิ้นใหม ่ 

 ข. แทรก > สร้างภาพนิ่ง เป็นการแทรกสไลด์ใหม่ในงานนําเสนอเดิม 

 ค. แทรก > สร้างภาพนิ่ง สามารถเลือกรปูแบบได้  

 ง. ถูกทุกข้อ 

12. ข้อใดคือข้ันตอนการแทรกสไลด์ที่ไม่ถูกต้อง  

 ก. แทรก > สร้างภาพนิ่ง 

 ข. กด Ctrl + M ที่ Keyboard  

 ค. แฟ้ม > สร้างภาพนิ่ง  

 ง. รปูแบบ > สร้างภาพนิ่ง 
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13. คําส่ังใดทีใ่ช้สําหรบัเปล่ียนแปลงรูปแบบของสไลด์  

 ก. รปูแบบ > แสดงภาพนิง่  

 ข. แฟ้ม > สร้าง 

 ค. สร้าง > รปูแบบของงานนําเสนอ  

 ง. ถูกทุกข้อ 

14. ถ้าต้องการสร้างไฟล์ใหม่ในขณะทีไ่ฟล์เดิมยังเปิดใช้งานอยู่ ต้องใช้คําส่ังในข้อใด 

 ก. แฟ้ม > จบโปรแกรม   ข. แฟ้ม > สร้าง  

 ค. แทรก > สร้างภาพนิ่ง   ง. รปูแบบ > สร้างภาพนิ่ง 

15. คําส่ังใดใช้สําหรับการปิดไฟล์งานนาํเสนอ  

 ก. แฟ้ม > จบโปรแกรม    ข. แฟ้ม > สร้าง 

 ค. รูปแบบ > จบโปรแกรม   ง. แฟ้ม > ปิด 

16. ข้อใดกล่าวถูกต้องที่สุดเกี่ยวกบัคําส่ัง บันทึก และบนัทึกเปน็  

 ก. บนัทึก เปน็การบนัทึกงานทีต่้องการระบุแหล่งที่เกบ็  

 ข. บันทึกเป็น การบนัทึกงานทีต่้องการระบุแหล่งที่เกบ็ หรือต้องการเปลีย่น 

ช่ือไฟล์ 

 ค. บันทึก เปน็ส่ิงทีก่ระทาํเพิ่มเติมลงไปในงานที่เคยผ่านการบนัทึกมาแล้ว  

 ง. ถูกทั้ง ข. และ ค. 

17. คําส่ังในข้อใดในการจัดรูปแบบตัวอักษร  

 ก. สร้าง > แบบอักษร      ข. มุมมอง > แบบอักษร 

 ค. รูปแบบ > แบบอักษร     ง. แทรก > แบบอักษร 

18. ข้อใดคือข้ันตอนการหมนุกล่องข้อความ  

 ก. รปูวาด > หมุนหรือพลิก > หมุนแบบอิสระ       

 ข. รูปแบบ > หมุนหรือพลิก > หมุนแบบอิสระ 

 ค. แทรก > หมุนหรือพลิก > หมนุแบบอิสระ        

 ง. มุมมอง > หมุนหรือพลิก > หมุนแบบอิสระ 
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19. คําส่ังในข้อใด คือข้ันตอนในการเปล่ียนรปูแบบของสัญลักษณ์แสดงหัวข้อย่อย  

 ก. รปูแบบ > สัญลักษณ์แสดงหัวข้อย่อยและเลขลําดับ > สัญลักษณ์แสดง 

หัวข้อย่อย  

 ข. รูปแบบ > สัญลักษณ์แสดงหัวข้อย่อยและเลขลําดับ > เลขลําดับ 

 ค. รูปแบบ > แบบอักษร > สัญลักษณ์แสดงหัวข้อย่อย  

 ง. รปูแบบ > แบบอักษร > เลขลําดับ 

20. กลุ่มแบบอักษร ในข้อใดที่แสดงผลเป็นสัญลักษณ์ของเครื่องหมายหน้าหัวข้อ  

 ก. Browallia New, Browallia UPC  ข. Arial, Comic Sans MS 

 ค. Cordia New, Cordia UPC    ง. Wingdings, Wingdings ๒ 

21. คํากล่าวในข้อใดกล่าวไม่ถูกต้องเกี่ยวกับการกําหนดสัญลักษณ์และเลขลําดับในสไลด์ 

 ก. เราสามารถเปลี่ยนเครื่องหมายหน้าข้อ เป็นรปูภาพกราฟิกเล็กๆ ได้ด้วยปุม่ 

รูปภาพ  

 ข. เราสามารถเปลี่ยนเครื่องหมายหน้าข้อ เป็นรปูภาพอักขระใดๆ ด้วยปุ่ม 

กําหนดเอง 

 ค. เราไม่สามารถกําหนดค่าเริ่มต้อนของเลขลําดับหน้าข้อได้  

 ง. เราสามารถเปลี่ยนขนาดและสีของเครื่องหมายหน้าข้อใดที่ ขนาด และสี 

22. ถ้าต้องการเปลี่ยนค่าเริ่มต้นของเลขลําดับหน้าหัวข้อย่อยในสไลด์ควรเลือกใช้คําส่ังใน

ข้อใด 

 ก. รปูแบบ > สัญลักษณ์แสดงหัวข้อย่อยและเลขลําดับ > เริม่ที ่:  

 ข. รูปแบบ > สัญลักษณ์แสดงหัวข้อย่อยและเลขลําดับ > เลขลําดับ > เริ่มที่ :  

 ค. รูปแบบ > สัญลักษณ์แสดงหัวข้อย่อย > เริ่มที่ :  

 ง. รปูแบบ > เลขลําดับ > เริ่มที่ : 

23. ถ้าเราต้องการนํารปูภาพทั่วไปทีจ่ัดเตรียมไว้ มากาํหนดเป็นสัญลักษณ์หน้าข้อ  

ควรเลือกใช้คําส่ังในข้อใด 

 ก. สัญลักษณ์แสดงหัวข้อย่อย > กําหนดเอง > นําเข้า                 

 ข. เลขลําดับ > รูปภาพ > นําเข้า 

 ค. สัญลักษณ์แสดงหัวข้อย่อย > รปูภาพ > นําเข้า                     

 ง. เลขลําดับ > กําหนดเอง > นําเข้า 
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24. ข้อใดคือข้ันตอนในการเปิดแถบเครือ่งมือวาดรูป  

 ก. เมนู แฟ้ม > แถบเครื่องมือ > รูปวาด                      

 ข. เมน ูเครื่องมือ > แถบเครื่องมือ > รปูวาด  

 ค. เมน ูแก้ไข > แถบเครื่องมือ > รูปวาด                     

 ง. เมนู มุมมอง > แถบเครือ่งมือ > รูปวาด 

25. ถ้าต้องการวาดรปูวัตถุประเภทวงกลมหรือสี่เหลี่ยมออกมาจากศูนย์กลาง เราจะต้อง

กดปุ่มใดค้างไว้ในขณะวาด 

 ก. กดปุม่ Shift ค้างไว้ในขณะวาด  ข. กดปุ่ม Alt ค้างไว้ในขณะวาด  

 ค. กดปุ่ม Ctrl ค้างไว้ในขณะวาด   ง. กดปุม่ Caps Lock ค้างไว้ในขณะวาด 

26. ถ้าต้องการเลือกวัตถทุั้งหมดที่อยู่ในสไลด์ จะต้องกดคีย์ลัดในข้อใด  

 ก. Ctrl + S  ข. Ctrl + A  ค. Ctrl + V  ง. Ctrl + C 

27. รายการคําส่ังในข้อใดใช้สําหรับการจัดลําดับของวัตถุ  

 ก. แฟ้ม > ลําดับ > เลือกคําส่ังย่อย                 

 ข. รูปวาด > ลําดับ > เลือกคําส่ังย่อย 

 ค. แทรก > ลําดับ > เลือกคําส่ังย่อย                

 ง. รปูร่างอัตโนมตัิ > ลําดับ > เลือกคําส่ังย่อย 

28. ถ้าต้องการหมนุหรือกลับด้านของวัตถุอย่างอิสระ จะต้องเลือกใช้คําส่ังในข้ันตอนใด 

 ก. รปูร่างอัตโนมตั ิ> ลําดับ > หมนุหรือพลิก      

 ข. รูปร่างอัตโนมัต ิ> หมนุหรือพลิก 

 ค. รูปวาด > ลําดับ > หมุนหรือพลิก                

 ง. รปูวาด > หมุนหรือพลิก 

29. ข้อใดคือข้ันตอนในการสร้างข้อความศิลป์  

 ก. แทรก > รูปภาพ > WordArt                    

 ข. แก้ไข > รปูภาพ > WordArt 

 ค. แฟ้ม > รปูภาพ > WordArt                     

 ง. เครื่องมือ > รูปภาพ > WordArt 

 

 

 

บัณ
ฑิต
วทิ
ยาล
ัย ม
หา
วทิ
ยาล
ัยร
าช
ภัฏ
สก
ลน
คร



103 

30. ถ้าต้องการสร้างไดอะแกรมสําหรับการแสดงข้ันตอนหรือวงจรการทํางานทีก่ระทํา

ต่อเนื่องกันเปน็วงรอบ เราควรเลือกไดอะแกรมแบบใดมาใช้งาน? 

 ก. ไดอะแกรมวงกลม (Cycle Diagram)          

 ข. ไดอะแกรมรัศม ี(Radial Diagram) 

 ค. ไดอะแกรมพีระมิด (Pyramid Diagram)       

 ง. ไดอะแกรมเป้าหมาย (Target Diagram) 

31. ถ้าต้องการสร้างกล่องข้อความผู้ใต้บงัคับบัญชาเพิม่ในผังองค์กรจะต้องเลือกคําส่ังใน

ข้อใด? 

 ก. แทรกรปูร่าง > Assistance   ข. แทรกรปูร่าง > Subordinate 

 ค. แทรกรูปร่าง > Coworker   ง. แทรกรูปร่าง > Subassistance 

32. ถ้าต้องการจัดรปูแบบของเส้นเช่ือมโยงทั้งหมดภายในผังองค์กร เราจะต้องใช้คําส่ังใน

ข้อใดเพื่อเลือกทํางานกบัเส้นเช่ือมโยง? 

 ก. เลือก > มาตรฐาน     ข. เลือก > สาขา          

 ค. เลือก > ผู้ช่วยทั้งหมด    ง. เลือก > เส้นทีต่ิดต่อกนัทั้งหมด 

33. ในกรณีทีเ่ราต้องการจดัรูปแบบกล่องข้อความในไดอะแกรมด้วยตัวเอง เราจะต้อง

เลือกคําส่ังในข้อใดเป็นอันดับแรก? 

 ก. เค้าโครง > เค้าโครงอัตโนมัติ   ข. เค้าโครง > รูปแบบอัตโนมัติ      

 ค. เลือก > สาขา       ง. เลือก > มาตรฐาน 

34. คําส่ังในข้อใดเปน็คําส่ังที่ใช้ในการแทรกรูปภาพ? 

 ก. คําส่ัง แทรก > รูปภาพ      ข. คําส่ัง แทรกรปูภาพ > ภาพตัดปะ 

 ค. คําส่ัง แทรก > รูปภาพ > จากเอกสาร ง. ถูกทุกข้อ 

35. คําส่ังในข้อใดไม่เกี่ยวข้องกับข้ันตอนการแทรกไฟล์เสียง?  

 ก. เมนู แทรก > รปูภาพ    ข. เมน ูแทรก > ภาพยนตร์และเสียง 

 ค. คําส่ัง เสียงจากไฟล์     ง. คําส่ัง เสียงจากการจัดระเบียบรปูภาพ 

36. ไฟล์ในข้อใดต่อไปนี้ไม่จัดอยู่ในตระกูลของไฟล์เสียง? 

 ก. ไฟล์ .WAV  ข. ไฟล์ .MP3  ค. ไฟล์ .MIDI  ง.ไฟล์ .AVI 

37. ไฟล์ในข้อใดต่อไปนี้ไม่จดัอยู่ในตระกลูของไฟล์วิดีโอ? 

 ก. ไฟล์ .WMV, ไฟล์ .MPG    ข. ไฟล์ .MP3, ไฟล์ .WAV 

 ค. ไฟล์ .DAT, ไฟล์ .AVI     ง. ไฟล์ .AVI, ไฟล์ .WMV 
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38. ถ้าต้องการให้ไฟล์เสียงเพลงเล่นวนซํ้าไปเรื่อยๆ จนกว่าจะหยุดการนําเสนอจะต้องใช้

คําส่ังในข้อใด? 

 ก. Loop continuously until ‘Esc’   ข. Loop until stopped 

 ค. Repeat until end of slide    ง. Repeat until stopped 

39. ถ้าหากต้องการกําหนดให้มีการเล่นเพลงไปเรื่อยๆ จนกระทัง่จบสไลด์ที ่40 จะต้อง

เลือกใช้คําส่ังในข้อใด? 

 ก. Start Playing : After 50 Slides ข. Start Timings : After Current Slides 

 ค. Stop Playing : After 50 Slides ง. Stop Timings : After 50 Slides 

40. ถ้าต้องการกําหนดระดับความดังของเสียงทีแ่ทรกในสไลด์ ต้องเลือกคําส่ังในข้อใด? 

 ก. ระดับความดังของเสียง > การตั้งเสียง  

 ข. การตั้งเสียง > ระดับเสียง 

 ค. ระดับความดังของเสียง > ระดับเสียง   

 ง. การตั้งเสียง > ระดับความดังของเสียง 

 

 

 

…………………………………………………. 
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แบบทดสอบผลสัมฤทธิ์ทางการเรียน 
เฉลย 

เรื่อง การใช้งานโปรแกรม Microsoft Office PowerPoint 2007 

      1. ค     2. ง   

      3. ข      4. ค   

      5. ค       6. ก   

      7. ค       8. ข    

      9. ค       10. ก   

      11. ง      12. ง   

      13. ง      14. ข     

      15. ง       16. ง   

      17. ค      18. ก   

      19. ข      20. ค   

      21. ก      22. ง   

      23. ค      24. ค   

      25. ค      26. ก   

      27. ข      28. ข   

      29. ก      30. ก   

      31. ก      32. ง   

      33. ข      34. ง   

      35. ก      36. ง   

      37. ง      38. ก   

      39. ก      40. ง 
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ตาราง 10 สรปุการพิจารณาความสอดคล้องระหว่างข้อคําถามของแบบทดสอบ 

             วัดผลสัมฤทธิ์ทางการเรียน 

ข้อสอบ

ข้อที่ 

คะแนนความคิดเห็นของผู้เชี่ยวชาญ 
รวม 

ค่าเฉลี่ย 

(IOC) 
สรุปผล 

คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 4 คนที่ 5 

1 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

2 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

3 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

4 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

5 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

6 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

7 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

8 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

9 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

10 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

11 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

12 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

13 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

14 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

15 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

16 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

17 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

18 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

19 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

20 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

21 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

22 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

23 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

24 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

25 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

26 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

27 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้
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ตาราง 10 (ตอ่) 

ข้อสอบ

ข้อที่ 

คะแนนความคิดเห็นของผู้เชี่ยวชาญ 
รวม 

ค่าเฉลี่ย 

(IOC) 
สรุปผล 

คนที่ 1 คนที่ 2 คนที่ 3 คนที่ 4 คนที่ 5 

28 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

29 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

30 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

31 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

32 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

33 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

34 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

35 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

36 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

37 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

38 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้

39 +1 +1 +1 0 +1 +4 0.80 ใช้ได ้

40 +1 +1 +1 +1 +1 +5 1.00 ใช้ได ้
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แบบประเมินความเหมาะสม เกณฑ์การประเมินชิ้นงานของนักเรียน 

คําชี้แจง 
 แบบประเมินนี้จัดทําขึ้นเพือ่ให้ผู้เช่ียวชาญ ได้ประเมินว่าแบบประเมินช้ันงาน

ผู้เรียนได้เรียนด้วยกิจกรรมการเรียนการสอนเพ่ือเสรมิสร้างความสามารถในการสร้างสรรค์

ช้ินงานโดยใช้โปรแกรม Microsoft Office PowerPoint 2007 สําหรับนักเรียนช้ันประถมศึกษา

ปีที่ 6 มีความเหมาะสมหรือไม่แล้วเขียนผลการพิจารณาของท่านโดยทําเครื่องหมาย () 

ลงในช่องคะแนนการพิจารณาแต่ละข้อ ดังนี้ 

  +1 หมายถึง เมื่อท่านแน่ใจว่าข้อความน้ันมีความเหมาะสมต่อการประเมิน 

      ช้ินงาน 

   0 หมายถึง เมื่อท่านไม่แน่ใจว่าข้อความนั้นมีความเหมาะสม 

      ต่อการประเมินช้ินงาน 

  -1 หมายถึง เมื่อท่านแน่ใจว่าข้อความน้ันไม่มีความเหมาะสม 

      ต่อการประเมินช้ินงาน 

 

 

 

    ขอขอบพระคุณอย่างสูง 

    นายสมบูรณ์  จงวัฒน์ 

    นักศึกษาปริญญาโท สาขาวิชาหลักสูตรและการสอน  

     มหาวิทยาลัยราชภัฏสกลนคร 
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แบบประเมินความสามารถในการสร้างสรรค์ชิ้นงาน 

เรื่อง กิจกรรมการเรียนการสอนเพื่อเสริมสร้างความสามารถในการสร้างสรรค์ชิ้นงาน 

โดยใช้โปรแกรม Microsoft Office PowerPoint 2007 สําหรับนักเรียนช้ันประถมศึกษาปทีี่ 6 

รายการประเมิน 
ระดับคุณภาพ คะแนนการพิจารณา หมายเหต ุ

ดีมาก 

(4) 

ด ี

(3) 

พอใช้ 

(2) 

ปรับปรุง 

(1) 
+1 0 -1  

ด้านเนื้อหา  

1. เนื้อหาครบถ้วน         

2. เนื้อหามีความถูกต้อง         

3. ขนาดตัวอักษรเหมาะสม         

ด้านภาพประกอบเนื้อหา  

1. ภาพกับเนื้อหามีความเหมาะสม         

2. ขนาดของภาพที่นํามา 

มีความเหมาะสม 

        

3. การวางตําแหน่งของภาพ 

มีความเหมาะสม 

        

ด้านองค์ประกอบของสี         

1. สีที่ใชส่วยงาม         

2. สีที่ใช้ตกแต่งภาพมีความเหมาะสม         

3. รูปแบบมีเทคนิคการใช้สี 

มีความเหมาะสม 

        

ด้านการนําเสนองาน  

1. นําเสนองานได้ครบถ้วนสมบูรณ์         

2. มีเทคนิคการนําเสนองานที่น่าสนใจ         

3. ใช้ภาพในการนําเสนองานได้

เหมาะสม 

        

 

ข้อเสนอแนะ 

.........................................................................................................................................

.........................................................................................................................................

......................................................................................................................................... 
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ตาราง 11 ความคิดเหน็ของผู้เช่ียวชาญที่มีต่อเกณฑ์แบบประเมินความสามารถ 

             ในการสร้างสรรค์ชิ้นงาน 

รายการประเมิน 
ผู้เชี่ยวชาญ (คนที่) 

รวม x  สรุป 
1 2 3 4 5 

1. ด้านเนื้อหา    

1.1 เนื้อหาครบถ้วน +1 +1 +1 +1 +1 5.00 1.0 ใช้ได ้

1.2 เนื้อหามีความถูกต้อง +1 +1 +1 +1 +1 5.00 1.0 ใช้ได ้

1.3 ขนาดตัวอักษรเหมาะสม +1 0 +1 +1 +1 4.00 0.8 ใช้ได ้

2. ด้านภาพประกอบเนื้อหา    

2.1 ภาพกับเนื้อหามีความเหมาะสม +1 +1 +1 +1 +1 5.00 1.0 ใช้ได ้

2.2 ขนาดของภาพที่นํามามีความเหมาะสม +1 0 +1 +1 +1 4.00 0.8 ใช้ได ้

2.3 การวางตําแหน่งของภาพมีความเหมาะสม +1 +1 +1 +1 +1 5.00 1.0 ใช้ได ้

3. ด้านองค์ประกอบของสี    

3.1 สีที่ใช่สวยงาม +1 +1 +1 +1 +1 5.00 1.0 ใช้ได ้

3.2 สีที่ใช้ตกแต่งภาพมีความเหมาะสม +1 +1 +1 0 +1 4.00 0.8 ใช้ได ้

3.3 รูปแบบมีเทคนิคการใช้สีมีความเหมาะสม +1 +1 +1 +1 +1 5.00 1.0 ใช้ได ้

4. ด้านการนําเสนองาน    

4.1 นําเสนองานได้ครบถ้วนสมบูรณ์ +1 +1 +1 +1 +1 5.00 1.0 ใช้ได ้

4.2 มีเทคนิคการนําเสนองานที่น่าสนใจ +1 +1 0 +1 +1 4.00 0.8 ใช้ได ้

4.3 ใช้ภาพในการนําเสนองานได้เหมาะสม 0 +1 +1 +1 +1 4.00 0.8 ใช้ได ้
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แบบประเมินแผนการจัดการเรียนรู้ 

 แบบประเมินแผนการจัดการเรียนรูน้ี้ ใช้สําหรับประเมินความเหมาะสม 

ของแผนการจัดการเรียนรู้การจัดกิจกรรมการเรียนการสอนเพ่ือเสริมสร้างความสามารถ

ในการสร้างสรรค์ชิ้นงานโดยใช้โปรแกรม Microsoft Office Power Point 2007 สําหรับ

นักเรียนช้ันประถมศึกษาปทีี่ 6 มีแผนการจัดการเรียนรู้อยู่ 4 หน่วยแบบประเมิน 

แผนการจัดการเรียนรูน้ี้ เปน็แบบประเมินโดยใช้มาตราส่วนประมาณค่า โดยกําหนดเกณฑ์

การให้คะแนนเปน็แบบจัดอันดับคุณภาพ แบ่งเป็น 5 ระดับ แต่ละระดับมีความหมาย ดังน้ี 
   5 หมายถึง เหมาะสมมากที่สุด 

   4 หมายถึง เหมาะสมมาก 

   3 หมายถึง เหมาะสมปานกลาง 

   2 หมายถึง เหมาะสมน้อย 

   1 หมายถึง เหมาะสมน้อยที่สุด 

 ขอให้ท่านพิจารณาแผนการจัดการเรียนรู้ ที่ผู้วิจัยสร้างข้ึน แล้วทําเครื่องหมาย / 

ลงในช่องทีต่รงกับความคิดเห็นของท่าน และโปรดให้ข้อเสนอแนะแก่ผู้วิจัย โดยเขียน 

ลงในช่องว่างที่เว้นไว้ท้ายแบบประเมิน เพ่ือเป็นประโยชน์แก่ผู้วิจัยในการปรับปรงุ 

แผนการจัดการเรียนรู้ให้มีคุณภาพมากยิ่งข้ึน 

 

 

          ขอขอบพระคุณอย่างสูง 

           นายสมบรูณ ์ จงวัฒน ์

      นักศึกษาปริญญาโท สาขาวิชาหลักสูตรและการสอน  

          มหาวิทยาลัยราชภัฏสกลนคร 
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ข้อ รายการประเมิน 
อันดับคุณภาพ 

หมายเหตุ 
5 4 3 2 1 

1 สาระสําคัญ       

 1.1 เขียนสาระสําคัญได้ถูกต้องเหมาะสม       

 1.2 สอดคล้องกับจุดประสงค์การเรียนรู้และเนื้อหา       

2 จุดประสงค์การเรียนรู้       

 2.1 สอดคล้องกับเน้ือหาสาระสําคัญ       

 2.2 ระบุพฤติกรรมการเรียนรู้ที่ชัดเจน       

 2.3 ระบุพฤติกรรมการเรียนรู้ที่สามารถวัดและประเมินได้       

3 เนื้อหา       

 3.1 ชัดเจนและถูกต้องตามหลักวิชาการ       

 3.2 เหมาะสมกับเวลาและระดับชัน้       

 3.3 สอดคล้องกับชีวิตประจําวันของผู้เรียน       

4 สื่อการเรียนรู้       

 4.1 สอดคล้องกับจุดประสงค์การเรียนรู้       

 4.2 เหมาะสมกับระดับชั้นของผู้เรียน       

 4.3 เหมาะสมกับเน้ือหา น่าสนใจ       

 4.4 ส่งเสริมให้ผู้เรียนได้เรียนรู้ด้วยตนเอง       

5 การจัดกิจกรรมการเรียนรู้       

 5.1 สอดคล้องกับจุดประสงค์การเรียนรู้       

 5.2 กิจกรรมมีความหลากหลาย       

 5.3 เน้นผู้เรียนเป็นสําคัญ       

 5.4 เหมาะสมกับความสามารถของผู้เรียน       

6 การวัดและประเมินผล       

 6.1 สอดคล้องกับจุดประสงค์การเรียนรู้       

 6.2 เคร่ืองมือวัดสอดคล้องกับขั้นตอนและกระบวนการ

เรียนรู้ 

      

 6.3 วัดได้ครอบคลุมเนื้อหา       
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ข้อเสนอแนะ 
…………………………………………………………………………………………………………………..…………………………

……………………………………………………………………………………..………………………………………………………

………………………………………………………………………………………………………………………………………………

………………………………………………………………………………………………………………………………………………

………………………………………………………………………………………………………………………………………………

………………………………………………………………………………………………………………………………………………

………………………………………………………………………………………………………………………………………………

…………………………………………………………………………………………………………………………………………….. 

 

 

           ลงชื่อ.................................................... 

               (..................................................) 

                ผู้เช่ียวชาญ 

               วันที…่…………/……………/…..……… 
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ตาราง 12 ความคิดเหน็ของผู้เช่ียวชาญที่มีต่อแบบประเมินแผนการจัดการเรียนรู ้

รายการประเมิน 
ผู้เชี่ยวชาญ (คนที่) 

x  S.D. 
สรุปผล 

ความเหมาะสม 1 2 3 4 5 

1. สาระสําคัญ    

1.1 เขียนสาระสําคัญได้ถูกต้องเหมาะสม 4 4 4 5 4 4.20 0.45 มาก 

1.2 สอดคล้องกับจุดประสงค์การเรียนรู้

และเนื้อหา 4 4 5 4 5 4.40 0.55 มาก 

2. จุดประสงค์การเรียนรู้    

2.1 สอดคล้องกับเน้ือหาสาระสําคัญ 4 4 5 4 5 4.40 0.55 มาก 

2.2 ระบุพฤติกรรมการเรียนรู้ที่ชัดเจน 5 5 5 4 5 4.80 0.45 มากที่สุด 

2.3 ระบุพฤติกรรมการเรียนรู้ที่สามารถ

วัดและประเมินได้ 5 5 5 4 5 4.80 0.45 มากที่สุด 

3. เนื้อหา    

3.1 ชัดเจนและถูกต้องตามหลักวิชาการ 5 4 4 4 4 4.20 0.45 มาก 

3.2 เหมาะสมกับเวลาและระดับชัน้ 5 4 4 4 4 4.20 0.45 มาก 

3.3 สอดคล้องกับชีวิตประจําวัน 

ของผู้เรียน 5 4 4 4 4 4.20 0.45 มาก 

4. สื่อการเรียนรู้    

4.1 สอดคล้องกับจุดประสงค์การเรียนรู้ 5 4 4 4 4 4.20 0.45 มาก 

4.2 เหมาะสมกับระดับชั้นของผู้เรียน 4 5 3 5 4 4.20 0.84 มาก 

4.3 เหมาะสมกับเน้ือหา น่าสนใจ 5 5 3 5 4 4.40 0.89 มาก 

4.4 ส่งเสริมให้ผู้เรียนได้เรียนรู้ด้วยตนเอง 5 5 4 5 4 4.60 0.55 มากที่สุด 

5. การจัดกิจกรรมการเรียนรู้    

5.1 สอดคล้องกับจุดประสงค์การเรียนรู้ 5 4 4 4 4 4.20 0.45 มาก 

5.2 กิจกรรมมีความหลากหลาย 5 4 3 4 4 4.00 0.71 มาก 

5.3 เน้นผู้เรียนเป็นสําคัญ 4 4 4 4 3 3.80 0.45 มาก 

5.4 เหมาะสมกับความสามารถ 

ของผู้เรียน 4 5 5 4 3 4.20 0.84 มาก 
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ตาราง 12 (ต่อ) 

รายการประเมิน 
ผู้เชี่ยวชาญ (คนที่) 

x  S.D. 
สรุปผล 

ความเหมาะสม 1 2 3 4 5 

6. การวัดและประเมินผล    

6.1 สอดคล้องกับจุดประสงค์การเรียนรู้ 4 5 5 4 4 4.40 0.55 มาก 

6.2 เคร่ืองมือวัดสอดคล้องกับขั้นตอน

และกระบวนการเรียนรู้ 5 5 5 4 5 4.80 0.45 มากที่สุด 

6.3 วัดได้ครอบคลุมเนื้อหา 4 4 5 5 5 4.60 0.55 มากที่สุด 

รวมเฉลี่ยทุกด้าน 4.35 0.54 มาก 
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แบบประเมินความพึงพอใจของผู้เรียนต่อการเรียนด้วยกิจกรรมการเรียน
การสอนเพ่ือเสริมสร้างความสามารถในการสร้างสรรค์ชิ้นงาน 

โดยใช้โปรแกรม Microsoft Office PowerPoint 2007 

คําชี้แจง 
 แบบประเมินนี้จัดทําขึ้นเพือ่ให้ผู้เช่ียวชาญ ได้ประเมินว่าแบบสอบความพึงพอใจ

ของผู้เรียนต่อการเรียนด้วยกิจกรรมการเรียนการสอนเพ่ือเสริมสร้างความสามารถ 

ในการสร้างสรรค์ชิ้นงานโดยใช้โปรแกรม Microsoft Office PowerPoint 2007 สําหรับ

นักเรียนช้ันประถมศึกษาปทีี่ 6 มีความเหมาะสมหรือไม่แล้วเขียนผลการพิจารณาของท่าน

โดยทําเครื่องหมาย () ลงในช่องคะแนนการพิจารณาแต่ละข้อ ดังน้ี 

  +1 หมายถึง เมื่อท่านแน่ใจว่าข้อความน้ันมีความเหมาะสม 

      ต่อการวัดความพึงพอใจ 

   0 หมายถึง เมื่อท่านไม่แน่ใจว่าข้อความนั้นมีความเหมาะสม 

      ต่อการวัดความพึงพอใจ 

  -1 หมายถึง เมื่อท่านแน่ใจว่าข้อความน้ันไม่มีความเหมาะสม 

      ต่อการวัดความพึงพอใจ 

 

 

    ขอขอบพระคุณอย่างสูง 

    นายสมบูรณ์  จงวัฒน์ 

     นักศึกษาปริญญาโท สาขาวิชาหลักสูตรและการสอน  

     มหาวิทยาลัยราชภัฏสกลนคร 
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ตาราง 13 ความคิดเหน็ของผู้เช่ียวชาญที่มีต่อแบบสอบถามความพึงพอใจที่มีต่อกิจกรรม 

             การเรียนการสอนเพ่ือเสริมสร้างความสามารถในการสร้างสรรค์ชิ้นงาน 

             โดยใช้โปรแกรม Microsoft Office PowerPoint 2007 

ลําดับกิจกรรมเรื่อง รายการประเมิน IOC สรุป 
1 2 3 4 5 

1. นักเรียนมีความพอใจในเนื้อหาที่เรียน +1 +1 +1 +1 +1 1 ใช้ได ้

2. การนําเสนอเน้ือหาทําให้เข้าใจได้ง่าย +1 +1 +1 +1 +1 1 ใช้ได ้

3. การจัดกิจกรรมการเรียนรู้ทําให้นักเรียน 

เกิดความสนใจ +1 0 +1 +1 +1 .80 ใช้ได ้

4. การจัดกิจกรรมการเรียนรู้ทําให ้นักเรียนเข้าใจ

เนื้อหาที่เรียน +1 +1 +1 +1 +1 1 ใช้ได ้

5. นักเรียนชอบการจัดกิจกรรมที่ให้นักเรียนได้ปฏิบัติ +1 0 +1 +1 +1 .80 ใช้ได ้

6. นักเรียนมีความพอใจที่ได้เรียนจากการใช้งาน

โปรแกรม Microsoft office PowerPoint 2007 +1 +1 +1 +1 +1 1 ใช้ได ้

7. นักเรียนมีความพอใจที่ได้ปฏิบัติชิ้นงานด้วยการใช้

งานโปรแกรม Microsoft office PowerPoint 2007 +1 +1 +1 +1 +1 1 ใช้ได ้

8. นักเรียนพอใจที่ได้สร้างชิ้นงานจากความรู้

ความสามารถของตนเอง +1 +1 +1 +1 +1 1 ใช้ได ้

9. เวลาที่ใช้ในการปฏิบัติงานมีความเหมาะสม +1 0 +1 +1 +1 .80 ใช้ได ้

10. นักเรียนพอใจที่ผู้สอนคอยให้การชี้แนะ  

และช่วยเหลือ +1 +1 +1 +1 +1 1 ใช้ได ้

11. การปฏิบัติงานทําให้นักเรียนเกิดความคิด

สร้างสรรค์ +1 0 +1 +1 +1 .80 ใช้ได ้

12. นักเรียนมีความพอใจกับการใช้งานโปรแกรม 

Microsoft office PowerPoint 2007 +1 +1 +1 +1 +1 1 ใช้ได ้

13. การสร้างชิ้นงานด้วยคอมพิวเตอร์ทําให้นักเรียน 

มีความเข้าใจเกี่ยวกับการใช้โปรแกรม PowerPoint 

2007 มากขึ้น +1 +1 +1 +1 +1 1 ใช้ได ้

14. นักเรียนพอใจที่ได้ทําใบงานและแบบทดสอบทันที 

ที่ศึกษาในแต่ละบท +1 +1 +1 +1 +1 1 ใช้ได ้

15. นักเรียนพอใจที่ได้ทราบคําตอบทันที หลังจากทํา

ใบงานและแบบทดสอบหลังเรียน +1 0 +1 +1 +1 .80 ใช้ได ้
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ตาราง 14 วิเคราะห์เปรียบเทียบผลสัมฤทธิท์างการเรียนคะแนนเฉลี่ยหลังเรียน  

คนที่ คะแนนเต็ม (40) คนที่ คะแนนเต็ม (40) 
1 35 18 32 

2 32 19 36 

3 33 20 37 

4 31 21 34 

5 36 22 35 

6 34 23 34 

7 32 24 33 

8 32 25 33 

9 35 26 35 

10 34 27 38 

11 38 28 37 

12 37 29 35 

13 33 30 34 

14 31 31 31 

15 30 32 32 

16 35 33 30 

17 34 34 36 

คะแนนรวม 1154 

x  33.94 

S.D. 2.201 

ค่าเฉลี่ยร้อยละ 84.85 

ประสิทธิภาพผลลัพธ์ E2 = 84.85 
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